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miniWRITER is a text-editing desk accessory with the following features:
• You can use all standard Macintosh features, including Undo.
• You can choose the font the text is displayed in.
• miniWRITER can print your document on an ImageWriter exactly as it appears 

on the screen — at ‘draft’ speed.  It can also command an ImageWriter to use 
boldface or underlined characters.

• miniWRITER can send a file to a LaserWriter as PostScript commands.
• miniWRITER can automatically use the ‘smart quotes’ used by typographers.
• miniWRITER tells you how many lines, words, and characters are in your 

document.
• Opens and saves TEXT files compatible with any word processor.

What’s In this Package You should have a desk accessory ‘suitcase’ file, a 
font ‘suitcase,’ two templates (TEXT documents), an appendix describing the 
details of ImageWriter printing, and this documentation.

Using miniWRITER
Use miniWRITER by choosing it from the  menu.  Its title window and main 

window open up.  Start work by clicking in the title window (or just start typing).  
Note that its menu (miniWRITER) appears in the menu bar.  You can remove 
miniWRITER from your desktop by clicking in the close box, or selecting Close from
the File menu.  Or, you can leave it on the desktop and bring another window to 
the front; miniWRITER removes its menu from the menu bar until you bring its 
window to the front again.

Enter text, select it with the mouse, and edit it using Cut and Paste, just as you
would with any Macintosh program.  When you want to save your work, use Save 
or Save as from the miniWRITER menu (not the File menu).  If you make a mistake, 
choose Undo from the Edit menu.

miniWRITER saves its documents as TEXT-only documents from MacWrite.  Lots
of other programs, such as QUED or Excel, can open TEXT documents.

If you save a document from a word processor as TEXT-only (Export File in 
Microsoft Works), miniWRITER will be able to open and edit it.

miniWRITER’s features are described in detail below.  You’ll want to read about 
them to get the maximum benefit, but you probably know enough already to use 
miniWRITER.

Features



Close Box
Click in the close box to close miniWRITER.  You’ll be warned about unsaved 

changes, if there are any.
Note that you can cancel closing miniWRITER with the close box, but you can’t 

cancel using an application’s Close menu item (for example, the one in Finder).

Zoom Box
Click in the zoom box to resize the miniWRITER window to the full screen (or to

80 by 60 characters, whichever is smaller).  Click again in the zoom box to return 
it to its previous size.

The zoom box will not appear in the upper-righthand corner of the window 
unless your Macintosh has a double-sided internal drive (i.e. the 128K ROM).

Scroll Bar
Scroll as you do in any other Macintosh program.
Holding down ⌘ while pressing the up-arrow or down-arrow keys is the same 

as clicking in the equivalent scroll bar arrow.

Edit Menu
Undo Z⌘

You can Undo just about anything in miniWRITER (except saving).  If you can’t, 
you’ll hear a short beep.

Clicking anywhere in the document ‘fixes’ the previous operation so that you 
can’t undo it.  But clicking in the scroll bar or size box doesn’t prevent an Undo.

Cut X⌘
Copies the selection to the clipboard, then deletes it.

Copy C⌘
Copies the selection to the clipboard.

Paste V⌘
If the clipboard contains text, it will replace the current selection.

Clear
Deletes the current selection.  The [Clear] key is equivalent to selecting Clear 

from the menu.  [Backspace] does the same thing, but also works when the 
selection is an insertion point.

New
Clears out the text you’re working with.  If you haven’t saved it, you’ll be given

the opportunity.



Open… O⌘
Displays a list of TEXT (and optionally, Red Ryder procedure) files.  If you open 

one, it will become the current document.  If you haven’t saved the text you’re 
working on, you’ll get a chance to.

Insert…
Replaces the selection range with a document you select.  The inserted 

document will be selected so you can see what you just inserted.
Insert… is handy for combining several documents.  If you insert the wrong file, 

just Undo!

Save S⌘
Saves the text you’re editing to disk.  Files are saved as TEXT-only MacWrite 

documents.
If neither MacWrite nor any other MacWrite documents are on the disk you 

save to, these files may appear with a generic blank document icon.  You should 
be able to restore the proper icon by dragging MacWrite or a MacWrite document 
to the disk (though the Finder may not reflect this immediately).

If you opened a Red Ryder procedure file, it will be saved as a Red Ryder 
procedure file, not as a TEXT file.

Save as…
Saves the text you’re working on to disk with a different name than it had 

previously (or to a different disk).  The original copy is not changed.  After you Save
as, future Saves affect the new document only.

Print…
ImageWriter

First format your document by adjusting the window to the width you want 
printed and choosing the appropriate font.  For the best quality printing, choose 
the imageWRITER 10 screen font from the Typestyle… menu, and Pica Proportional 
printer font from the Print… menu.  (If you must have a monospaced printout, 
chose the Monaco 9 or Courier 10 screen font [they have the same spacing] and 
Elite printer output.) This guarantees that line lengths on the screen and paper 
will match.  (There is no screen font with the same spacing as the printer’s Pica, 
but Monaco 12 is close.)

Choose Print… from the miniWRITER menu; you’ll see this dialog:



Choose the built-in font you want the ImageWriter to use.  Pica Proportional 
produces the most attractive printout, and it corresponds exactly to the 
imageWRITER font.  The other fonts are mono-spaced; they’re less attractive, but 
can be useful if you’re trying to line up text exactly.

miniWRITER normally slashes zeroes so they can be distinguished from capital 
Os; this is especially important when working with computers.  You can turn off 
this feature.

miniWRITER normally prints 60 lines on a page, then skips to the next.  If 
you’re using different sized paper, or want different margins, you can change this.
You may also need to change it if your text isn’t single-spaced.  miniWRITER 
normally uses 40 lines per page if you have selected 1.5 line spacing from the 
Typestyle… menu, 30 lines per page for double spacing.

If you have an ImageWriter II printer, you can choose Draft quality (characters 
with the same resolution as on the original ImageWriter), or NLQ (the printer’s 
built-in Near Letter Quality font).  On an ImageWriter I, either selection results in 
Draft printing.

If you have a sheet feeder on your ImageWriter II, check the Sheet Feeder box.
This instructs miniWRITER to print three blank lines on the top of each page, and 
not to go to the top of a new page after printing.  If you’re using A4 paper in a 
sheet feeder, set the lines per page to 62.

miniWRITER can print all the symbols in the imageWRITER font.  Its 
performance has not been tested with other symbols.

LaserWriter
First format your document by adjusting the window to the width you want 

printed and choosing the font you want to use for printing.  
Choose Print… from the miniWRITER menu; you’ll see this dialog

If your document is actually a PostScript program, click the PostScript box.  
miniWRITER will send the text to the printer as PostScript commands.  It won’t 
report any error messages sent by the LaserWriter, so this feature is best used for
sending PostScript files you’ve already debugged.  There is an implied showpage 
at the end of your PostScript file.



Find… F⌘
Search for a sequence of characters.  The search is circular — miniWRITER 

starts after the selection range, scans until the end of the document, and 
continues from the beginning.  Upper- and lower-case letters are treated the same
in a search, but letters with diacritical marks (e.g. ‘é’) are considered distinct.

Find Next N⌘
Repeats the last Find operation with the same search text.

Typestyle… T⌘
The Typestyle… menu item offers you a dialog box where you can choose the 

font, size, and line spacing used for miniWRITER’s text.

All text is in a single typestyle.
The dialog uses the scrolling list feature which is found in Apple’s System file 

3.0 or later.  If miniWRITER can’t find the list resources in the System file, you 
won’t be able to change typestyle.

Note that the typestyle is used only for screen display; miniWRITER prints only 
with built-in printer fonts (except to a PostScript printer such as the LaserWriter).

Plain Codes P⌘
Inserts, in front of the current selection, the character codes which revert to 

normal printing on an ImageWriter printer.  You’ll be able to see these characters 
on the screen, but they will not print on an ImageWriter.  The imageWRITER font 
contains special overlapping characters so not as much screen space is used; 
other fonts will probably show them as boxes.

Future versions of miniWRITER will implement styled printing on a LaserWriter, 
but for in this version, don’t use the various codes.

Bold Codes B⌘



Inserts the character codes which start boldface printing on an ImageWrite 
printer.  If a range of characters is selected, the codes to turn off boldface printing
will be inserted after the selection.  You’ll be able to see these characters on the 
screen, but they will not print on an ImageWriter.  The imageWRITER font contains
special overlapping characters so not as much screen space is used.

Underline Codes U⌘
Inserts the character codes which start underlined printing on an ImageWrite 

printer.  If a range of characters is selected, the codes to turn off underlined 
printing will be inserted after the selection.  You’ll be able to see these characters 
on the screen, but they will not print on an ImageWriter.  The imageWRITER font 
contains special overlapping characters so not as much screen space is used.

Select All A⌘
Selects all text in the document.

Options…
Smart ' "

Checking the ‘smart quotes’ option instructs miniWRITER to use a left or right 
apostrophe or quote when you type ' or ".  This gives your work a much more 
aesthetic appearance — typesetters almost never use the ‘neutral quotes.’  
miniWRITER uses the correct quotes without your having to worry about which 
[Option] characters to use.  Be sure to turn off smart quotes if you’re preparing a 
document to be uploaded with a communications program.  Most computers do 
not know how to handle smart quotes (you’ll see something like “itUs” instead of 
“it’s”).

Changing this option won’t change text already in the document.

Break lines on ‘-’ ‘—’
Choose this option to have miniWRITER wrap lines after a minus sign or ‘em 

hyphen.’  If you turn off this option, miniWRITER will only break lines on ‘white 
space’ — one or more spaces or tabs.

Note that [Option]-minus (–, the ‘en hyphen’) is a ‘hard dash’ — miniWRITER 
will not break a line at one.  This is analogous to the [Option]-space, the ‘hard 
space,’ which is also non-breaking.

The ROM routines that miniWRITER uses may not properly display the ‘-’ or ‘—’
at the end of a line.  If you notice this, make your window a tiny bit larger, or turn 
off this option.

Open Red Ryder procs
If you check this option, miniWRITER will open and edit procedure files used by

the Red Ryder terminal program.  If you use this option, I assume you’ve made 
two shareware payments.  One to me and one to Scott Watson.



Save settings in document
Checking this option instructs miniWRITER to save Options… and Typestyle… in 

the document.  This makes the document slightly larger, but does not interfere 
with other programs that want straight TEXT files.  It’s useful so you don’t have to
set your preferences each time you open a document.

Settings are saved in the resource fork; the typestyle is saved in the same 
EFNT resource used by MDS Edit and QUED.

Get Info I⌘
Reports the number of lines, words, and characters in the document being 

edited.  The number of lines depends on the current window margins.  The word 
count is the actual number of words, and thus may not be the same count a 
journalist would use.

TABs
miniWRITER does not (yet) use tab stops, but the imageWRITER 10 font shows 

where TAB characters are located in a text file.  Anyplace the imageWRITER 10 
font shows a little horizontal arrow in a miniWRITER document, that is a TAB 
character.  The screen print below shows how the TAB characters look when you 
are using miniWRITER:

In some fonts (particularly LaserWriter screen fonts), the tab character has no 
width at all.  Rest assured, the tabs are there.

Installing miniWRITER
Use Apple’s Font/DA Mover to install the miniWRITER desk accessory and the 

imageWRITER font into all the System files you use regularly.
If you install miniWRITER using DA Installer+, miniWRITER may not be able to 

print.  This is due to a bug in DA Installer+ (at least in the version I have; check 
with Dreams of the Phoenix for the latest information).

Using the Envelope Templates
First, make sure the imageWRITER font is installed in your current System file.  

Open the appropriate template with miniWRITER and change your return address 
(be sure not to change any of the funny characters!), then save the document.  
From now on, you’ll only have to change the address portion.  Again, be sure not 
to change any funny characters.  When you print, open the envelope flap so you 
can close the paper bail over the envelope.



These templates are designed for an ImageWriter printer only.

Compatibility
With the new ROMs, the imageWRITER font causes a conflict with a similarly 

named or numbered font in Telescape.  The person who reported this problem 
was able to get around it by editing imageWRITER’s FOND resource in the System 
file to include the FONT in the Telescape file.

Setting Preferences
Defaults

miniWRITER is distributed with imageWRITER 10 as the default font, and with 
Smart Quotes, Dash Line Breaks, Open Red Ryder Prcs, and Save Settings chosen.
It saves documents as MacWrite text-only files.

Eventually, there will be a program to set the default typestyle and options.
Currently, you’ll have to edit the ‘mWRT’ resource.  The ‘suitcase file’ contains 

a ResEdit  ‘TMPL’ resource to make this easier.  Make a copy of the suitcase file 
and open it with ResEdit.  Select the TMPL, choose Copy, then paste it into 
ResEdit.  This instructs ResEdit how to handle mWRT resources, and you can now 
edit the mWRT resource from miniWRITER.

If you have installed the mWRT TMPL before, you’ll need to do it again, since 
the resource format has changed slightly.

Designing Characters
For information on designing your own characters to be printed on the 

ImageWriter, see the appendix (in a separate document).

PostScript
The PostScript text is preceded by a save and followed by a restore.  These are

contained in ‘POST’ resources.

The Honor System
This package is available only through the honor system.  Install it and try it 

out for a week or two.  If you use it, please send $12 to:
Maitreya Design

PO Box 1480
Goleta, CA 93116  USA

If you decide not to use it, get rid of all your copies (or better yet, pass them on to
someone else).

miniWRITER cannot be ordered from Maitreya Design; please do not send us 
purchase orders.  Contact us if you’re interested in paying for a number of copies 
(a ‘site license’), or if your organization requires an invoice.



You can make as many copies as you like, and give them to all your friends.  
Please include this documentation and the imageWRITER font when you pass out 
copies.

We believe that this method of distribution benefits the consumers by giving 
them a chance to evaluate the product before handing over their hard-earned 
pay.  It also means that Maitreya Design doesn’t have the headaches of traditional
marketing, and can devote more of its energies to writing more Macintosh 
software.  There is, of course, a catch.  The middleman gets nothing.  Actually, the
catch is that it depends on YOU.  I’ve got a lot more features I want to include, but
if I don’t receive payments, I have to assume no one is using miniWRITER, and 
there’s no point in spending more time on it.

Upgrades will be posted on the major communications networks (currently 
Delphi and CompuServe), from which user groups normally obtain such software.  
We rely on these sources for our distribution.  If you just can’t get upgrades that 
way, you can send a formatted disk with return postage and a self-addressed 
envelope.  I urge you to try all other means of getting revisions; if I’m swamped 
with copying disks, I’m not going to get much programming done.

If you’ve paid once, you never need pay again.  We don’t believe in charging 
for updates, no matter how many features they may add.

If you have any questions, you may call us at 805/968-7578, as long as you 
promise not to call before noon Pacific time.  Ask for David Dunham, since he 
wrote miniWRITER.

Brought to you by
Acta

Acta is the tool for people who write.  Use Acta to prepare and organize 
your manuscripts, reports, journals, seminars, documentation, schedules, and for 
almost any other kind of writing.  Even if you’ve never used an outline processor 
before or are unfamiliar with outlining, you’ll find Acta helps you write better by 
allowing you to organize your thoughts as well as your words — while you write.

Every application can have a built-in outline processor.  Acta is a desk 
accessory, which means you can use Acta with MacWrite or Microsoft Word — 
moving back and forth between your outline and manuscript.  Outlines transfer 
into any application — just copy and paste.

As easy to use as the Macintosh itself.  Just let your thoughts and ideas 
flow into topics.  Then move to the next level or go even deeper.  Now move 
topics around to organize your thoughts or with a double-click of the mouse, hide 
or reveal each level.  If you change your mind, Undo.  Sort alphabetically or 
search for a particular word.  Acta even includes a utility program to customize 
Acta to your ways and to convert ThinkTank documents to Acta documents.

Acta can organize your business as well as your writing.  Keep track of 
submissions, create a directory of terms, take notes, create lists.  You can even 
Paste pictures from the Clipboard or Scrapbook into outlines.



Acta is only $59.95, and is available from your dealer, or
Symmetry Corporation
761 E University Dr Suite C
Mesa, AZ   85203
800/624-2485  [in AZ 602/844-2199]

Power Fonts
Power Fonts go beyond the capabilities of the standard Apple fonts with:

     •  Better legibility and style.
     •  A much wider size range.
     •  A much larger selection of “Option Characters,” including:
          •  Virtually all the Greek characters for scientific
                         papers/equations/etc.
          •  Roman numerals
          •  The Macintosh special characters (, ⌘, etc.)
          •  Special arrows, underlines, and solid border enclosures.

Power Fonts provide four of the most usable Macintosh typefaces available 
today.  

The backbone of the font set is “Clarity,” a professional sans–serif typeface, 
optimized for extremely legible ImageWriter and ImageWriterII dot matrix 
printing.  Clarity’s legibility remains exceptional in sizes from a tiny 6 point to a 
big bold 36 point.

An improved line of monospaced fonts is provided by the “Montclair” series.  
These print much more clearly than Apple’s “Monaco” font and are available in a 
much wider array of sizes.

“Strasbourg” and “WindyCity” are an added bonus.  They produce distinctive 



and stylish special purpose correspondence.
     •  Strasbourg is an extra wide typeface as pioneered in the Modern European 
studios.
     •  WindyCity is a double–bold typeface in the style of Chicago, but 



               with better character styling and improved legibility.

The complete set of Power Fonts are available for only $15.00 from: 
       Altsys Corporation
       720 Avenue F, Suite 108
       Plano, Texas  75074
       (214) 424-4888

Altsys is the creator of the excellent font editor, FONTastic.  Ask for their brochure 
if you are interested in customizing your Power Fonts for some special purpose.

Thanks to
Charlie Maurer, for suggesting miniWRITER.
Bill Layman, for suggesting WYSIWYG printing and designing the imageWRITER

font (and putting up with my criticisms).
Numerous testers who helped me remove most of the bugs (no program is 

ever 100% bug free).

Fine Print
miniWRITER is a trademark of Maitreya Design.  Apple is a registered trademark of, and Macintosh is a 
trademark of, Apple Computer, Inc.  PostScript is a trademark of Adobe Systems Inc.  Documentation and 
program ©1986,1987,1988 Maitreya Design.  imageWRITER font ©1986 W.E. Layman.

Maitreya Design is not responsible, etc. — but we do use miniWRITER ourselves.  We will try to fix any bugs.

This documentation corresponds to miniWRITER version 1.4 (but it may not be updated as frequently as the 
desk accessory).


